
Experience a customer support organization that is committed to your satisfaction and is ready to 

provide award-winning service. The Sage Construction and Real Estate support team is comprised 

of highly skilled professionals who can answer your questions quickly to keep your system operating 

at maximum efficiency. Because all of our analysts receive extensive training and testing before 

they take their first phone call and have access to a wide range of comprehensive tools, you can be 

assured that you will obtain the most knowledgeable, up-to-date information available. 

Before You Contact Customer Support 
 

Before you decide to contact customer support, gather as much information as you can about your 

problem or error message. You have access to our Sage Knowledgebase, an on-line Help (which is 

included with your software), and many other resources that enable you to answer questions or 

troubleshoot problems on your own. These services are available 24 hours a day, seven days a week. 

Please see below for detailed information about the resources, in addition to our Customer Support 

analysts, that are available to help you.

Sage Timberline Office and Sage Master Builder Help—You can access help about specific 

procedures, topics, fields, or buttons from anywhere in the software. 

Sage Knowledgebase—Our staff maintains an extensive knowledge database of frequently asked 

questions, solutions to problems, and source documents. You have access to this knowledgebase 

at www.sagecre.com or through the Help menu in the software. Search for solutions and find the 

latest information on issues you may be having. 

Technical Documentation Available on the Software CDs—A number of user guides are included 

on the software CDs we ship to you. Important release information such as system requirements, 

software enhancements, and more can be accessed quickly and easily. 

Sage Summit Customer Conference–Interact with and learn from Sage Construction and 

Real Estate senior leadership, product experts, and fellow customers in one location. Get the latest 

on product updates as well as network and share experiences with your peers. Check our 

Web site for current conference information.  If you are a PremierCare subscriber, you receive  

a 20% discount to this conference if you enroll during the Super Saver period.

Local Users Groups—Interact with peers and business partners to network, share ideas, and 

solve problems. Additionally, an independently organized group of Sage Timberline Office clients, 

the Timberline Users Group (TUG), meets regularly to discuss issues relating to their software.  

To learn more, visit the group’s Web site at www.tugweb.com.

Prepare to Contact Customer Support 
 

The following information is designed to help you get your software questions and issues resolved in 

a timely manner and to save you valuable time in the process. 

When you call customer support, our call routing system or a customer support analyst will ask 

you for the following information. Be prepared to answer these questions each time you call.
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Question                                                         How to Find the Answer 

What is your client ID number?  Your client ID number can be found on 

correspondence you receive from Sage.  

If you cannot locate your client number,  

a customer support analyst can look it up  

for you.

What CD version are you using? Sage Timberline Office:

To find the version of the accounting products, 

open TSMain; click Help > About TS-Main 

and note the number next to CD Version. To 

find the version of the estimating products, 

open Estimating; click Help > About 

Estimating and note the number next to 

Version. You can also right-click the estimating 

icon for a more detailed version number.

Sage Master Builder:

To find the version, open Sage Master 

Builder; click Help > About Sage Master 

Builder and note the number next to version 

within the parenthesis.

What application are you calling about? Identifying the application that you are calling 

about will help you navigate quickly through 

our telephone menu prompts. See Pg. 7  

of this guide for speed dial tips for Sage 

Timberline Office.

How can we help you? Walk through the exact steps you completed 

with as much detail and accuracy as possible. 

Is there an error message? Write down the exact wording of the message. 

For Sage Timberline Office, in the application 

in which you were working, select Help > 

System Log and scroll through the file to 

find the error message

Can you reproduce the issue? Walk through the same steps that led to the 

problem and see whether it happens again.

Is this the first time the problem has happened? 

Does the problem occur on one workstation 

or several?

Ask other operators if they have experienced 

the same problem. Have them test at their 

workstation to see if they experience the 

same problem. Also, have the original operator 

try other workstations to see whether the 

problem is specific to that operator.

Has anything changed with your software, 

hardware, or workflow?

Ask your network administrator for technical 

information regarding anything that may 

have changed behind the scenes: upgrades 

to Sage Timberline Office or Sage Master 

Builder applications, new third-party 

software installations, moving of data from 

one server to another, new printers or print 

driver installation, or anything else that might 

affect the network.
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Question                                                         How to Find the Answer 

Does the problem happen in the sample 

data sets?

Sage Timberline Office:

In the application in which you were working, 

select File > Open Company and choose 

one of the sample data sets that came with 

the software. Perform the same steps that 

led to the problem to see whether it occurs 

while using the sample data. 

Sage Master Builder:

Select File> Open Company, then change 

the drive letter on the dropdown to C:, select 

Sample Company.

For technical or network problems such as computer freezing or locking, printer problems,  

or applications ending suddenly, please answer the following questions as well.

What kind of network are you using? Contact your network administrator.

What operating system is on your 

computer?

For XP:

Click [Start], click [Run], type winver and 

click [OK]. 

For Vista:

Click [Start], type winver in the ‘start search’ 

window and click [OK].

What printers and print drivers are installed? Contact your network administrator.

When was your last backup? Contact your network administrator.

Question                                                         How to Find the Answer 

Guidelines for Supported Issues and Categories 

When you encounter issues with your Sage Construction and Real Estate software, the cause 

 can sometimes be related to an external circumstance rather than to the software itself. For example, 

the problem may be with your network hardware or configuration, other software you have 

installed, or a workstation’s operating system. Our customer support team members will do 

whatever they reasonably can to keep your system up and running, but some issues reach 

beyond the support included with your service plan. If you encounter difficulties that you cannot 

resolve through the technical support team, one of our certified consultants can assist you with 

problems specific to your setup or operation.

The following sections describe the categories of issues that the customer support team 

can address. 

Page 3 of 8

Sage Construction and Real Estate         Customer Support Guide



Topics Covered                                              Topics Not Covered

We provide support on the two most recent 

mass shipment releases (the current version 

and one prior). 
 

General Sage software configuration 

questions. 
 

”How-do-I” type questions. 
 

Error or warning messages occurring within 

software. 
 

Suggestions on source of reconciliation 

difficulties.

Design or detailed configuration of 

customer database. 
 

Training or tutorials on the function 

and use of Sage software.  
 

Performing reconciliation of Sage 

software modules. 
 

Performing reconciliation of external 

reports to Sage software.

Versions Supported

Sage Timberline Office Crystal Decisions Writer and Report Designer

Sage Master Builder Report Writer and Form/Report Page Design

Topics Covered                                              Topics Not Covered

”How-do-I” type questions. 
 

Functionality of default Sage reports (the report 

works the way it was intended to work). 
 

Troubleshooting the Report Designer, Report 

Writer, and Crystal applications. 
 

Crystal Decisions and Report Writer 

installation and linking to Sage Timberline 

Office data. 
 

Report Writer and Form/Report Page Design 

linking to Sage Master Builder data. 
 

Any situation where there is a known issue 

or potential issues with default Sage reports.

Creation of or modification of reports. 
 

Troubleshooting modified reports. 
 

Custom report upgrades. 
 

Design or setup of data.   

Extracts using Crystal Decisions.

Topics Covered                                              Topics Not Covered

Operating Systems as they relate to

Sage installs and functionality.

Operating system installation or 

configuration.

Installation or configuration of software not 

purchased from Sage or a Sage Business 

Partner.

Configuration of TCP/IP or other 

communication protocols.

Installation
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Printers

Troubleshooting software printing error 

messages or malfunction.

Standard installation of Sage Construction 

and Real Estate recommended print drivers.

Recommendations on printer purchases 

other than what is defined in the Sage 

Knowledgebase.

Topics Covered                                              Topics Not Covered

Networks

Accessing Sage Construction and Real 

Estate software over a supported network.

Assistance with non-supported networks..

Topics Covered                                              Topics Not Covered

ODBC

Setting up a successful DSN connection.

Create a DSN to ensure accessibility of

Sage Timberline Office data in Microsoft

Access or Excel.

Creation, configuration or troubleshooting of 

tables or queries.

Topics Covered                                              Topics Not Covered

Third-Party Software

Troubleshooting software errors that occur 

during data transfer.

Installation, configuration, or use of  

third-party software.

Topics Covered                                              Topics Not Covered

Customer Support Call Responses 

Our goal is to answer inbound customer telephone calls within the first three minutes. Once calls are 

answered, analysts resolve over 90% of questions during the first interaction. If unable to resolve, the 

analyst will take care of you personally by placing your call in their in-progress log for further research 

and follow up. The support analyst will stay in contact with you until a resolution or agreement can 

be reached.
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Our customer support team works with you to identify call urgency and responds accordingly.  

Call urgencies range from a simple explanation of software settings to critical situations in which 

work is stopped or data integrity is compromised. The table below lists our support call priorities  

and the response you can expect to receive from a customer support analyst.

 

You may check the status of an open support ticket, update new information you’ve discovered on an 

open issue, or create a non-urgent request for help online. Just visit www.sagecre.com and click Logon. 

Next, select the Support tab and choose the Self Service button.

Very High You are unable to conduct business until 

this issue is resolved. 

Example: Your system is down, processing 

has stopped, and you are unable to perform 

an urgent task or a Sage Construction and 

Real Estate Certified Consultant is onsite.

We work diligently with any 

resources needed to get your 

system functioning again.

High Your issue is of a timely nature; however, 

your system is not down. 

Example: You have a government report 

due in a limited timeframe or we have asked 

you to call us back on your open incident.

Your issue is a priority to us, and 

we work with you to resolve it in 

a timely manner.

Medium Your issue is very important; however, 

your software operations can continue 

without immediate resolution.

Example: New Payroll deduction 

setup required before printing payroll 

checks later in the week. 

We work with you to resolve your 

issue in a timely manner.

Low Your issue is important and your 

software operations can continue 

without immediate resolution.

Example: You want to know more about 

a feature that you may implement later.

We work with you to answer 

your questions in a timely 

manner.

Priority         Definition                                                   Response you can expect
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Contact Customer Support 

United States and Canada 

www.sagecre.com

Sage Timberline Office toll free: 800-551-8307

Sage Master Builder toll free: 800-866-8049 

International: 503-690-6775

For Sage Timberline Office, you can use this speed-dial menu list to help you quickly reach the most 

qualified analyst when calling into Customer Support for a new technical support question. After you 

enter your client ID, use the speed-dial numbers to immediately by-pass the entire menu and go directly 

to the support area you want to reach.

Keep in mind, for reporting, ODBC, Address Book, and / or file doctor it is best to select the application 

that best applies where the data is being produced.

For information about service plans
 

Call 800-858-7098 

Sage Timberline Office press 1.

Sage Master Builder press 2.

Accounts Receivables, Contracts, or Billings 32

Accounts Payable 21

Cash Management 23

Document Management 24

Estimating 1

General Ledger 22

Job Cost 41

Networking, Operating Systems, Installation, or Activation Codes 7

Payroll 31

Project Management 42

Property Management or Residential Management 6

Purchase Order or Inventory 51

Service Management 52

For Other Assistance 0

For assistance with                                                                                   Speed Dial
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Customer Support Hours 

Online support incidents can be submitted 24 hours a day, seven days a week by logging 

on to www.customers.sagenorthamerica.com. Our customer support team will reply 

to your questions during normal support hours. Telephone support is available Monday 

through Friday from 6 a.m. to 5 p.m. Pacific time with the following exceptions:  

s฀%VERY฀4HURSDAY฀FROM฀�฀P�M�฀TO฀�฀P�M�฀0ACIlC฀TIME�฀WHEN฀CUSTOMER฀SUPPORT฀IS฀
   closed for staff meetings. 

s฀3TANDARD฀5NITED฀3TATES฀HOLIDAYS�฀

s฀1UARTERLY฀COMPANY฀MEETINGS�฀

You will also be kept informed of the dates that Sage Construction and Real Estate support 

will be closed via our regular customer e-newsletters. This information is available online at 

www.sagecre.com as well. 

Sage Construction and Real Estate Customer Support: Continually improving for you 

At Sage, we understand that your success is our success. We want to help you drive business 

productivity and profitability. So, our goal is simple—to offer unparalleled support and services to our 

customers for the life of their software.

We always strive to provide the most effective and responsive technical support and a broad 

range of resources.  When you invest in Sage, we make a commitment to be with you every step 

of the way as you implement, deploy, and use your software now and far into the future. And this 

commitment is backed by our customer care organization that rates second to none among the 

world’s premier software organizations.

We frequently seek feedback from our clients to discover ways that we can deliver a higher level of 

service. At the conclusion of selected support incidents, you may receive a customer satisfaction 

survey. Please help us by answering the survey and sending suggestions on how we can better 

serve you.
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